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Quick comparison

Excel Online Surveys Office 365 Forms Google Forms

v’ Great for short, specific surveys, | v Great for a flat form that require | v'Best for complex forms that may

such as dates for meetings, or no separate sections require sections, automated &
“will you attend” type surveys v Best if only one person needs to real-time data manipulation
v Access via Excel Online work with the responses v’ Best for multiple owners

v'Data is stored in Excel Online
and can be shared with multiple

people
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Excel Online Surveys

Creating a new survey

a) Go to my portal and sign in with your
Campuswide ID and Password

b) In the Employee Tab click “Launch Office 365"

C) Click on the “Excel” icon
d) Open a “New blank workbook”
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e) Click on the “File” tab to save your Excel Workbook

«in i ——
e T e e
Save As
ey The g - Save s
- 's Crwata ol ooy of i fil i e merw e foicee
S Fmar 8 ramas o shis oy
’ Surveylaae
Frrsarus Fopbra pdefing Ml
Dawsinadl & Cop
DCewnicad m 005
. eve oors .l % Vcmacs * 1 o
f)  Click the Home Tab (or o e T
alternatively the Insert Tab) Asos § MyPonal [ Outiook Wes Ase < footn-Dw Anza O s [ Ocogeroms [ Omeiiodete o On . [ Lawning Mesconce. . (] Oice 2018 for Ma.
\S Wronge G

0) Click “Survey” to open drop
down menu

h) Select “New Survey”

i) Create your survey by entering
information in each
placeholder

NOTE

The field “Enter a description for your

Bt Survey

Esies & descriplian foe your survey hefe

Just start typing

Enter a title for vour survey here
here

Enter your firsl queition bere

survey here” will look like it's not ) A M Epussition
going to fit in the screen, but it will
once completed.
i) There are a number of different question types
(called Response Type): Responsa Typs
o Text -
Required

e Paragraph Text

e Number
e Date

e Time

e Yes/No
e Choice
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NOTE
If you do not want recipients to be able to continue/ submit a survey without answering a specific question, you
can tick the ‘Required’ checkbox.

| Wi Serven
A ——

k) When you have finished designing your
questions click “Save and View” in the bottom
right to preview what the survey will look like

Atiendance at the next meeting

Finsse A1 cux this sarvey 12 b un know shoat wour menchacs o G0
PExs g

| Cam yum anrnd e mew mening?

) If you are happy with the survey as it is click =
“Share Survey”, otherwise click “Edit Survey” to
continue working on it B e EeL

]
Urrem i i | Py e ki | bep [ e

m)  Copy the link into your email or webpage

Share Survey (‘& -H

Give the link below to anyone you'd like to share this survem

329432058%:2DE950%2042A0%2D54F0%2DDF35F180C458% 70
Stop sharing this survey

Close

NOTE
Recipients do NOT need Office 365 in order to view or fill out the survey.

Sharing the survey at a later stage

a) Log into Office 365 and Excel (see above for instructions)
b) Click on the saved survey

C) Click on “Edit in Browser” to be able to edit the survey

d) Click “Share Survey”

e) Copy the link into your email or webpage

Share Survey x

Give the link below to anyone you'd like to share this survey with:

| hitps://foothilldeanza-my.sharepoint.com/personal/20307688_fhd

Close
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Editing the survey after having closed it

a) Log back into Office 365 and Excel (see above for instructions)
b) Click on the saved survey

C) Click on “Edit in Browser” to be able to edit the survey

d) Click “Edit Survey” to make any changes necessary

e Ry i
i [ bipuma s s e s b B & 0[] P, [ S B g Pamacms 1] e b

B W i Poese D ke 8 (] Sl i Hom u ! O B i
M+ * @ Secuw werefoodhildennoe rey Sharegoint com
B oam B UyPwiad Cubinh Wl App Prarial Dm A T 10 [ Nmgin Pewes ) G iy d [ 1ewrsry Pesmae . []] Con 708 b b

Eeced Onling 19 tromoe vl B B, ey

f- Ca= veu simad the nert reawdng T

Closing the survey

a) Log into Office 365 and Excel (see above for instructions)
b) Click on the saved survey

C) Click on “Edit in Browser” to be able to edit the survey

d) Click “Share Survey”

e) Click “Stop sharing this survey”

Share Survey x

Give the link below to anyone you'd like to share this survey with:

hitps://foothilldeanza-my.sharepoint.com/personal/ 20307688 _fhd
Stop sharing this survey

Stop Sharing Survey? x

Are you sure you want to stop sharing this survey? If you do, no one will be able to submit responseas.

Stop Sharing This Survey Cancel

i? TIP
To share the workbook, which contains the survey results, click “Share”in the
upper right corner of your screen and choose your sharing preferences. :q. Share

Instructor: Created by: Lilith Krueger-Gilka
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Office 365 Forms

Creating a new form e - .

T LOC P ORI NG SR SR M SO 7 SRR ———

b) Go to my portal and sign in with your
Campuswide ID and Password

e Fonfal Calloge
Y T D
Coflege

Ws e P T wr
B 00 Sy i o B

C) In the Employee Tab click “Launch Office 365”

-t v O e Y i g e

i Sy tep ——

L 1 OOl | &
PR e i
T TPV PFIR Y , ISR S NS S S -

d) Click on the Forms icon

e) Click “New Form” to create a new form

® B S S o g

At Brrw o A it 1 e (] s e

O e 0w Loy a1 o 3054 5 A

Fiuw fe0l Ol SO uises

N vy Woow Gt a
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f) Change the name of the form - - —— 5
0) Add an image (if you like) by clicking the — . =

“add image” button
E Untitled form

OfFfics 385 Forrms E

NOTE
A Any time you see the “add image” button, you can use it to add images

h) Start adding questions by clicking on “+ Add question”

g | a R et 8 L
£ 0 4 e
e e s it i i T (B P i e iy e (e B
Soa il L i -
]Uf"r .
- Office 365 Forms sow g . B —— . o
DIEEOEE Py e———
g Bt i B i e 0 B P i e g e i
i iy e S i e e Doy 30 By ety
pe g b -
o e

JOffic office 365 Forms

. . i (o g
i) There are a number of different o
guestion types:
e Choice x=---|--|...._|_ ]
o Text
e Rating
e Date

Instructor: Created by: Lilith Krueger-Gilka
Last Updated: Feb 2017



DeAl
(fl Col lere;gzg

Using forms to capture information — Handout -

Choosing a design theme for your form

When you have finished your form layout you can
change the design theme of the whole form by clicking
on the “Theme” tab in the top right corner.

Previewing your form

To preview your form, and see what your form looks like to recipients (Computer vs Mobile), click on the “Preview”
Tab in the top right corner.

T T &

[Rre— Y, R

s coonr 90 vou pote e o
Lot

Wi cotowr de pou e Ret o Gruee

Creating branching for your form

If you want recipients to go to a specific next question based on the answer to a
specific question you have to create the branching as follows:

S00Id40fAEK_VUNFpVINNWOVRLIST M.

aming Resnufea

a) To set up branching for
your form click on e W (0 o B o

the “...” in the top B 8 o L i i e

right corner h—

Branciing opfons

b) Select “Branching”

1. Thich oolour do you preler; Recl or Green?

oo Gty e e

G T w
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C) Select the how you would like your form to flow after each question with the “Go to” drop down menu

® 9 g MyPorw|Feomit-De Anza © x ' [] Mewsoft Offica Home % ' [ Microac Forma . e
¢ C & Secure Mips.//forms.office.convPagesDesignPags. aspx ¥ 1=n7LIRQCOUYATINEGhZ SKWISIMYYI50QJI401TGK. VUNFDYNINWOVRUSTM
¥ Agps § MyPoral O Outiook Web App < Foothis-De Anza C.. €7s [£) Google Forms ) OmniUpdate at De .. ) Learning Resource... [ OMce 2016 for Ma.
€ s
Branching options

1. Which colour do you prefer: Red or Green?

Red GO 0 | Next question

Green Goto | ¥ Next question

End of the form

2. Tell me what you think about this topic. L. Tek me what you think about this topic
3. How do you rate this question?

4. What 5 your favourite day of the year?

2. Tell me what you think about this topic. Ga e Next question w
Change settings
a) To change the settings for your form click on the “...” in the top right corner
b) Select “Setting” o
e This is useful to set up e [ Sharm
Jd40f7GK_VUNFpVN|NWOVhUSIM... |
i. who will have access
g Resourca.,, T A o i Seltings
ii. and for how long 9

® Theme s
Who can fill out this form
Branching

Angone with the ink can respond

Sattings Becond rame

DN ESpOnEa e pRrSOn

Fendhack
Options for responses

B Accept responses.
Skart date
End dete
ShiiMe qastions

Instructor: Created by: Lilith Krueger-Gilka
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Sharing the form

a
a)  Click the “Share” button in the upper right corner Y
b) Choose one of the following sharing options: Share -

@  will give you a link to copy into your email or webpage Send and collect responses

Onfy peophe i my organtzation can respond -

QR o will give you a QR code that recipients can scan on a phone or J e

tablet to access the form
| @ » =
o will give you an iframe to embed the survey in a webpage and the
=f= like Share as a template

+ Get a link to duplicate

e will create an email in Outlook that already includes the link to the Share to collaborate

form + Get a link to view and edit

K

Viewing the responses

a) Click the “Responses” tab to see a summary of responses per question
b) Click the “Open in Excel” icon in the Responses area to download a spreadsheet of the responses

C W [E ool foes u [ e 38 Premy " a
i Pl il [ Bt - s |[looogia Feees ) Deeiupdate sl Ge . D) Usavig Mmiewon . (] G 1000 b Ma

Qustions Rzsporses )
MH e 3 = B Oficn M5 Foma (1)
365 Fo o Puge Lot Fastrodis Duiksi Rirwiaw  Whirw Talw .
r. . Caioei [Bosk)  » 11 =+ fla A= E % § Condiicral Formaiting -.._.. . Q
| . - e Fievail ink Tyt *
Fask B I w & . i v Mgeren Haer 7 Cul Bytan - Cills Exiiag
PR 00:24 .
Aarida i 0 oSS & "
@hichopkardoyes Tol meabeipe How dopouess ik @ s yeer
D R LT TR B T gaenaal iaants duy of e
= L iR AFIENE P LA RLEP DOl eda o LN Grumger Gilka R
¥ UITI43138 LOH? L0 TN vl LN dnueger Gla Groen 4 Lrama
4 AETiddaAE AFIENE P LA AP 3R MO0l Mede g LN Gunger Gilka S i ANaHa
eh elour 6 i prifer: Rid ar Gesn? 3 UBMITIAAZI]  LFMAT LD ST fdac Ll Snuger e
L
w
"
i Ehamall +
Faady LT m - — — + wx

TIP
You can choose to create a “quiz” instead of a form to give feedback based on your responder’s answers — as
long as the questions are multiple choice.

Instructor: Created by: Lilith Krueger-Gilka
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) W HE 7 Thems Share T
Closing the form
5 Settings
a) Log into Office 365 and Forms (see above for instructions)

b) Click on the saved form Whao can fill out this form
Arwore with the link can respond

C) Click on the “...” icon in the top right of the screen to open more
. © Only peaple in my organization can respond
options
B Record name
d) Select “Settings” O response per persan
e) Un-tick the “Accept responses” checkbox to stop recipients from
being able to fill out the form Options for responses
ALCERE NESPONSES
Redpients aren't able to fill out and

submit this form,

Message bo recipients

This form & curmently nob acoepting
TREQONGES.

Instructor: Created by: Lilith Krueger-Gilka
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Google Forms

NOTE
A You will need to have a google account to access this. It is an easy 2-step process that will take a few minutes.
Creating a new form

a) Go to forms.google.com in your preferred browser
b) Click “+” to create a new blank form

® © % E Googe Forms x e
<« C & Secure hittps//docs.google.com/farms/w o
i apps @ MyPorts O Outiook Web App - Foothi-De Anza ©... - ETS [E] Google Forms [ OmniUpdate at De... [ Leaming Resource... (] Office 2016 for Ma

— Google Forms Q Search

Start a new formy TEMPLATE GALLERY ~

+

atact Information Party Invite T-Shirt Sign Up

Recent forms i a2 i [ ke gn s [ Gongie Form [} Cerveiioneie wn e[| Lowrsing Pmmowre . [ Oicm 16 for e

Untitled form
Untitled Question &) vhlgn chaic -
piion | !
- o
O Emires
[}
WO O Sy ke - iy P 5 B

C) Change the name of your form

P AT T T ae——

T dpon g sbvForw [ Dureod YVea kor T iy dmyw G ers [fdcege form [} Cevsiiomse mide . [ Lewrmry Pesowme . []] Dfice 18 o s

Google forms I

Ty 1 £ prer b gl by s

neaso

Untithed Question

(1]
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d) Start adding questions by clicking on the “+” button
= Short answer
e) There are a number of different question types:
= Paragraph
e Short answer
[+)
e Paragraph @ Multiple choice
e Multiple choice - Tr
L4 Checkboxes
e Checkboxes |
e Dropdown © Dropdown o
e Linear scale -
. . . *++ Linear scale -
e  Multiple choice grid
° Date ] ﬂ Multiple choice grid
e Time b ™
3 Date
f) Add an image (if you like) by clicking the 5 “add image” button © Time
next to the Question title
Google forms
-]
Quesian 1 ) Tr
- ) ?
B O%  [O secge e - ooge Feey - L]

el e W woitew  bedh e e ¢ 9 £ 5 Seam hysocegoople.com bt | DOFpisd SOB0I0AGIW N VG
B oAms e U Dun Vs A Pt D Ak G T [ e Perws [ Gt o 3

[I[Toe— TR

Google forms

Thes 5 10 e fom googe farre war

Question 1

NOTE
A You can also use the floating menu on the right to add an image or a video u

Instructor: Created by: Lilith Krueger-Gilka
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NOTE
If you want to make it mandatory for recipients to answer a
question switch on “Required” at the bottom right corner of

the question.

Creating sections for your form

O

If you want recipients to go to a specific section based on the answer to a specific

guestion you have to create the sections as follows:

a) To add sections to your form use the floating menu on the right

L [ g e
- | @ Secure  hHps oo oo pom sk DM D4 chc AN P 1YY

= B WPone 0 Dariood Wed Asa

QUISTIORS

-l

If you chose Yes

A pection I Gota section § (Dverpans snce up hars)  ~

If you chose No

Afwr wection 7 Goia section § (Everpans snds ug hers) -

Focani-Dn Anra O (7} nmm. UL Oeriopans e M Laawing Recaas . T OFfca SE78 10 s

_’

d) Click the Options icon (three dots) at the bottom right corner of the question
e) Select “Go to section based on answer,” and assign the section to each answer
f) Select the how you would like your form to flow after each question with the “Go to” drop down menu

Thi e i Tl s

b

Yes of Mo?
ven .|

Instructor: Created by: Lilith Krueger-Gilka
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Choosing a design theme for your form

When you have finished your form layout you can change the design theme of the whole form by clicking on

the “Theme” icon m in the top right corner.

® © ® ) Googe forms - Google Forms x e
— C | @ Secure hitps’//docs.google.com'forms/d/1 DGhg20pd deGA0A0AGXWUSJWFrWWImrW_dToMGSq_4/edit o
i Apps  § MyPortal O] Outiook Web App G Foothin-De Anza G...  C ETS [E] Google Forms ) OmniUpdste st Do . ] Learning Resowce .. [ Ofice 2016 for Ma.

€« WQ forms AY chenges saved i Deive

QUESTIONS

Google forms

Thiz is %0 show how google forms work.

Preview your form

To preview your form, and see what your form looks like to recipients, click on the “Preview” icon m in the top
right corner.

®  ® [ coogeioms - Google Farms e

o

€ = O | i Secun  hitps:Ydocs.goog e, comfoms/d’ DG hg2Dp4deGa30AENWUsWFAWWIMIW_dTolMGE5Sg 4/edit

i Apps B MyPortal 0] Outiook Web App -0 Foathin-De Anga G, TS [ Google Forms. ) O=nilipdete & De.. [ Learsing Mesaurce.., [ Ofice 2016 for Ma

Sharing your form

a) Click the “Send” button in the upper right corner

®  ® [ coogeioms - Google Farms a

o

€« = (@ | i Secune  hitpsyYdocs.goog e, comfoms’d’ DGEhg2Dpe deGa 030AENW U WFrWWImIW_dToMGE5g_4/edit

i Apps 8§ MyPomal 0] Outiook Web App O Foathin-De Anza G, 75 [ Google Forms ) O=nilipdete & De.. [ Learning Mesaurce

3 Ceficm 2016 dor Ma
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b) Choose one of the sharing options:

e Emall
e Link
e Embedded

e via Google+
e via Facebook
e via Twitter

Send form X

|:| Collect usernames

Send via n n

C) Depending on which option you choose you will have to
e click “Send” or
e click “Copy” or
e be redirected to your Google+, Facebook or Twitter accounts

Viewing the responses

a) Click the “Responses” tab to see the responses either as a summary or per individual response

® 0@ B ccoge toma - Googhe Forme w e
&= = (|8 Secure  Mipedocs.goaghe. camTarmad’ DEhgDpddoRalI0AGCW R WFARWIMIY_dToM G5 4sdiliaeapansss | §
if! Apps '§ MyPormal || Cutiook 'Web App -0 Foothil-De Anza G... -0 ETS [E] Googie Forms ) Omnilipdais a2 De.. [ Leaming Resouroe... [ Offios 2016 Jor Ma...

QUESTIONS

2 responses

Instructor: Created by: Lilith Krueger-Gilka
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b)
c)
d)
e)

Closing the form

a)
b)
c)
d)

Click the “Create Spreadsheet” icon in the “Responses” tab

Select “Create a new spreadsheet”

Click “CREATE”

This will create a Google sheet that automatically updates every time someone completes the form

® % [E] acogu lams - Googla Forms « -
& = | 8 Secure  Mitpe/docs.googhe. camTome’d’ | DEhgR0paduGa030ARNWLSIWFANWIMAW _dToMGE5G 4editfeapandss k
! Apps U§ MyPormal | D] Cutiook Web App -0 Foothil-Die Anza C... ETS EGmnln Forms [ Omnilpdeie a2 De... [ Leaming Resowoe... (] Office 2016 1or Ma.

“ Gmﬂ TOIMNE AN changes s = Deva

2 resnnness

Select response destination by

(@) Crele 8 new spreadshest Google forms (Responses])  Learn Mere

() Select existing spreadshest
§ ' ® [ coagsfems - Geagie Fowa = - [J] Googe roems (Fussonsss

O Herurn B des gotgh tan

EAMCEL Goeoghs Mo (Resporae] L]

Ve Welat Fraval Dush Tesh Foen AS1sR s

_

POm o3 U3 Ak " [ & -BH =
i § . H

= [l

" f :
! emierw |Gt Fomirs st o s i Yoo o Mo

1 HVHAT TR 18 Oplon & 13500 Al e
a HVRET TIER A Dphin B0 P Ha

Hiapes WP O Cubees B AR T FONSE-Ce A G Er3 [ Cueee Forra [ Cvweiaeaste 1 Do ) edresg Riesid

L= e=lll

Log into forms.google.com arsnens | wsronses (6
Click on the saved form 2 responses
Click on the “Responses” tab m INDIVIDUAL ®

Switch “Accepting responses” to off

Useful query for attendance sheets

If you want to create individual attendance sheets based on a form you can use the following query to
separate the responses based on a specific qualifier in the form. In this case, it is “Student”

=query('Form Responses 1'!B2:$N, "Select B,C,D.E,F,G,H,I,J.K,L,M,N where B='Student'")

28N 2 2"

Name of the sheet Cell Cells you want included -
L ) Qualifier
containina the data ranae in the new sheet
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